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Year 2016 

 

Release 2016.16.03 / November 

We have devoted this release to enhancing Practice Management features. 

Enhanced Features 

 
Enhancements to Practice Management  

 Custom Telephone Labels.  A new option provides a customized template for the four basic telephone labels that are used 
throughout Practice Management.  Those labels are: 

 
• Telephone 1 
• Telephone 2 
• Telephone 3 
• Fax 

 
Use of 4 Phone labels include: 

Clients and Client Contacts, Business Affiliates and Business Affiliate Contacts, Referrals, Leads / Lead Contacts. 

  

Use of 3 Phone labels include: 

Offices.   Telephone 1 Label maps to Office Telephone 1. 

Telephone 2 Label maps to Fax 2. 

  Fax Label maps to Office Fax 1.   

 

 Use of 2 Phone labels include: 

Firm.    Telephone 1 Label maps to Firm Telephone 1 

Fax Label maps to Firm Fax.   

 

Employees.   Telephone 1 Label maps to Employee Telephone 1. 

Telephone 2 Label maps to Employee Telephone 2. 

 
 
  Group Field Enhancements.    

• Group Name setup has been moved to the 1st tab of the Client Folder. 
• The characters allowed for this field has been expanded from 7 characters to 45 characters. 
• A new option provides the ability to turn off the default of the client sort name. 

This option is located in the Administration module > Firm Setup > General Information. 
 

 CPE Reporting.  There is a new reporting requirement for certain states to include the unique identifying number of the sponsor 
used to acquire CPE credits.  A new field, Sponsor ID, has been added to the CPE entry in both Employee Setup and in Time 
Entry.  The Employee CPE Report now includes the new field. 
 

 Standard Client Listing.  The Client Listing found on the Client Tab in standard reports includes both client and prospects as an 
option.  Now included is an identifier indicating whether Client or Prospect for each name.  This report criteria provides the user 
the ability to print both clients and prospects or filter for one or the other. 

 
 New Look and Feel.   The Main Menu has new icons for a new look and feel. 
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Technology Upgrades 

 Internet Time Entry Users.  Please review the following settings and refer to the “Install Internet Time Entry” document located 
in the doc folder of the server application directory.  You may need to make the following modifications depending on your 
version of IIS. 

• The .NET CLR version for the application pool should be set to 4.0.30319 to correspond to .NET Framework 4.0. 
• The two ASP.NET v4.0.30319 restrictions set to Allow. 

 

Corrections 

 Accounts Receivable Statements.   Column header ‘Invoice” is now included when using the Balance Forward format type 
statements. 

 Remote Time Entry.  Time entry records are now consistently recorded to the correct date for remote users in a different time 
zone from the main office. 

 Reports 

• Client Listing now defaults to print Active clients and prints an expanded engagement description.  Additionally, the output 
breaks correctly where the secondary sort is group. 

• Employee Time Analysis exports PTD (RTD) Hours and PTD (RTD) Amounts to Excel correctly with the Group Billable 
Nonbillable with Subtotals enabled. 

• Employee Budget Report no longer wraps data incorrectly. 

 Report Writer.  Employee List type reports correctly include the CPA Exam fields from employee setup. 
 Contact Management.  List of Clients by Business Affiliates/Contact no longer display for BA firms and contacts that have been 

removed. 
 Custom Library.   Billing Worksheet no longer generates an error selecting to summarize data by category, subcategory or service 

code. 
 

 

Release 2016.16.02 / August 

We have devoted this release to making technology upgrades. Please see details below.  

 

Technology Upgrades 

Microsoft® .Net Framework Upgrade to 4.6.1 – All modules have been updated. 

Dxperience – Report Writer – A major upgrade that now supports export to the Excel format xlsx increases the limitation of rows that it 
can handle from 65,536 to 1,048,576. 

 

Microsoft® SQL Server® Upgrades 

Microsoft® ends extended support for SQL 2005 
 
 MS® SQL Server® 2005.  Practice Management will support SQL 2005 through December 31, 2016.  Microsoft ended their 

extended support for SQL 2005 on April 12, 2016.  If you are currently on SQL 2005 version (SP 4), you can directly update from 
2005 to 2014 or higher.  If you are not on Service Pack 4, you will need to upgrade to any intermediate version (2008/2008R2) 
before version SQL 2014.  We recommend you migrate to 2014. 

 
Microsoft® SQL Server® Express 2014 
 
 MS® SQL Server® Express 2014.  This release of Practice Management has shipped with version 2014.  If you are on an older 

version of SQL Server® Express, we recommend you migrate to 2014. 
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Corrections 

 Report Writer:  Changes made to increase the speed with which data is returned if an office filter is applied to the report output. 
Affected report types include: 

MTD/YTD Client Billing 
MTD/YTD Employee Billing 

 Dashboard:  Error message no longer generated selecting a dashboard where user did not have security enabled to the main 
security item for the Project Tracking module. 

 
 Apply Later Distribution:  Selecting to lookup a client following the application of a filter to the results previously loaded into the 

grid no longer generates an error.   

 

 Reports:  Selecting to export a report to Microsoft Excel defaults to the xlsx format. 

 

 

 

 

Release 2016.16.01 / May 

We have devoted this release to enhancing Practice Management features as well as making technology upgrades. Please see details 
below.  

 

Enhanced Features 

 
Enhancements to Practice Management Billing  

 An additional option to Transfer Progress in the Progress Distribution section.  For firms that invoice multiple engagements on a 
single invoice and apply progress amounts from multiple engagements, the transfer progress option will be much more 
convenient in the same area as the distribution is configured. 

 Re-organization of the Billing Client List buttons now include all options that pertain to the entire client list at the top of the 
screen. 

 
• Select the Client List. You may now stay on the billing Client List screen and change the filter for the client list. 

 Only your clients with WIP greater than $0 
 All your clients 
 Only your Fixed Fee clients  

 

• Select a list of Clients for Specialized Billing 

 Apply Progress  

Click this button after choosing to see clients with WIP greater than $0 or all clients to bill all of your clients with an 
outstanding progress amount from a client list which provides the ability to quickly bill these clients without going 
into a WIP selection process and creating one invoice at a time. 

 

 Fixed Fee Billing 

Click the Fixed Fee button under the Select Client List to bring up your list of Fixed Fee clients.  This action enables 
the Fixed Fee Billing button under Special List Billing.  You now have two choices for billing these clients.  You can 
bill one at a time or you can use the Fixed Fee Billing special list method which provides the ability to quickly bill 
these clients from a list without going into a WIP selection process and creating a single invoice at a time. 
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Note:   Because these two specialized billing options require different client lists, one of the two buttons is enabled 
at a time. 

 

• New Edit Options from the Menu Bar 

 The “Change Bill Thru Date” option 

Click this option from the menu bar to limit the WIP available to bill. Enter a cutoff date in the Bill Through Date 
field. All posted WIP entered on or before this date netted with any unapplied progress will display in the WIP 
column for each client in the list.  If the WIP Approved Date is enabled and the value input is not equal to the 
current system date, a new column “Thru Date” will display for reference (if a selected column).  

 

 The Change Client Biller option  

Click this option from the menu bar to select a new biller. This menu option opens the Bill List Criteria window. 

 

• The Billing Recap option has been moved to the top of the Client List.   
• The Print Invoice option has moved to the top of the Client List.   

 

 New preference options to order or remove the Client List columns.   Go to the Menu bar > Preferences to find a new option to 
order and select the columns that you want in your grid.   

• The option provides a list of the default columns and a list of the columns that you select.  Columns that you do not select 
will not appear in your grid.  You may move columns in the order that you prefer. 

• The columns that are static are the Billing/Invoice Status and the Client Sort Name. 

 
 

 There are now two sort options when selecting WIP to bill by employee.  The All Emp tab sorts and groups WIP by all employees 
regardless of the engagement while the Eng/Emp tab sorts and groups WIP by engagement by employee.  The All Emp tab was 
requested to be brought back after we added the sort and group by engagement by employee in the 2015.15.03 release. 

• Sort and group the WIP by all employees 
• Sort and group the WIP by engagement by all employees 

 

Enhancements to Dashboards 

 Client Dashboard.   In the past, the client dashboard has not included a view of the client projects.  Now there is a new project 
tab that provides a view of all of the projects for the client selected.  In addition if the client has multiple engagements, there is a 
checkbox to provide a view of all the client engagement projects.   

• Choose a project or projects from the grid and select the Project Time & Exp button to view the WIP (unbilled, billed or 
both) associated with the project.  Information displayed includes the in charge employee, the total project budget hours 
and the total budget amount (if using budgets).  The view comprises the following columns: 

Transaction Date 

Employee 

Service Description 

Hours 

Units (if expense units required) 

Fees if time service 

Expenses (if expense service) 

Surcharge  

Invoice number if billed and posted 
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  Firm Dashboard.   

• My Projects Tab:  For client managers using the firm dashboard, My Projects Tab now includes a new view of the employees 
who are assigned to the projects.  So a manager at any level who needs to know who is working on a project can look it up 
easily by selecting the Assigned Emp button. 
 

• My Project Overruns Tab:  For client managers who are using My Project Overruns Tab on the firm dashboard, there is a 
new view available from the Project Time & Exp button.  This view is outlined above for the new Project Tab on the Client 
Dashboard. 

 

 

Enhancement to Practice Management Utilities 

 You may now change an employee code.  Use this utility available from the Administration main menu> Utilities > Change 
Employee Code to replace a current employee code for a selected employee.  The system will prevent you from using a code 
that is already in use by another employee.  Employee codes must be unique and are stored on history files. 

 

New and Enhanced Standard Reports 

 Daily Timesheet.   A new option is now available to print an associated memo with each transaction. 
 Service Code Invoice Paragraph List.  A new standard report is now available to print invoice paragraphs associated with 

Categories, Subcategories and Service Codes.  The criteria selection provides options to limit the number of paragraphs to print.  
 

Enhanced AR Statement Setup 

 AR Format for Remaining Only Statements.  The option to print an AR Statement in summary format for clients that want a 
statement only showing the invoices that have a remaining outstanding balance is now outlined on the Format tab of the AR 
Statement criteria setup.  To set up this format: 

• Set the AR Method in the Firm Setup to Open Item 
• Set the Statement Balance Forward date = Statement Cutoff Date 
• Set the Statement Format Type to Open Item 

 

Integration with CCH Axcess™ 

 

Enhanced Error Notifications 

 Error notifications for interruptions to the daily update now run from the Practice Management server.  In the past the Practice 
Management CCH Axcess™ Monitor was installed on a dedicated workstation or a server and the program used email for 
notifying any interruptions to the update process.  Because a dedicated workstation may be turned off, administrators did not 
receive an email warning about an interruption.  Now the CCH Axcess™ Monitor is installed on the Practice Management server 
and notifications use services to notify designated employees. 
 
 

Technology Upgrades 

 

Compatibility with Microsoft® Products 

 MS ® Office 2016.  Practice Management is compatible.  (except for Home and Mobile editions) 
 

 
 
Microsoft® ends extended support for SQL 2005 
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 MS® SQL 2005.  Practice Management will support SQL 2005 through December 31, 2016.  Microsoft ended their extended 
support for SQL 2005 on April 12, 2016.  If you are currently on SQL 2005, you cannot directly update from SQL 2005 to SQL 
2014 or higher.  You must migrate to either SQL 2008 or SQL 2012 before migrating to SQL 2014. 

 

Corrections 

 Accounts Receivable 

The Finance Charge Register totals are now correct if previewed more than once. 
The AR Register now prints correctly when a large batch of entries are included. 

 Administration 

Year-end procedures processing performance has been enhanced for speed. 
Employee budget setup now sets the selection of a week and sets focus to the appropriate week when selecting a day of 
the week other than Sunday. 

 Basic Edition.   

If you are using projects for your due dates in the Basic Edition of Practice Management, you can now double click to 
expand the Roll Projects to the New Year node in Project Management. 

 Billing 

Print Invoices (Batch Printing) from the primary billing window has now been enhanced for speed. 
You can now print the Billing Edit List without first selecting the Invoices tab. 
The Invoice Email Summary Report now includes all clients selected. 

 Contact Management 

WIP Aging now displays the correct Aging buckets when the progress balance exceeds the WIP balance. 

 Custom Library Reports 

The Billing Worksheet no longer generates an error when the Client Staff Position ‘Manager’ is selected as the 2ND sort field 
and the Current and/or Prior Year History boxes are checked in the Options window. 
The Billing Worksheet now displays values for the custom fields. 

 Reports 

The Employee Productivity Report now calculates the correct totals. 
The Client Monthly Comparison Report no longer creates an error when attempting to run the report excluding all available 
selection criteria. 

 Time Entry 

The Time Entry input performance has been enhanced for speed when using projects. 
The expense total displayed when entering expenses now ties to the Time Entry Edit List.  

 

 

 

 

 

 

 

 

Year 2015 

 

Release 2015.15.04 / December 
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We have devoted this release to enhancing the Integration of common data from Practice Management to  

CCH Axcess™.    

New Remove restrictions for firms qualifying to use the Integration to CCH Axcess™  

 Practice Management firms that are currently using Active Directory or ADFS with their CCH Axcess™ products may now qualify 
to manage their common data in Practice Management and electronically update their CCH Axcess™ database. 

 
Help About Practice Management > Additional Information 
 Additional information under Help About now has the number of user licenses available for the firm as well as the number of 

user licenses currently used. 
 

Corrections 

 Reports 
o Project Status Report no longer generates an error when selecting to export to Excel®. 

o Monthly Comparison Report totals correctly when run multiple times in succession with change to sort. 

 Transfer Progress Amounts 
Security options to transfer progress amounts from one engagement to another engagement is now active for Basic 
Editions. 
 

 Clients_In Table 
Custom field sizes have been increased. 

 

Release 2015.15.03 / November 

We have devoted this release to making enhancements and corrections to the billing module in Practice Management as well as 
enhancing the Integration of common data to CCH Axcess™ . 

Please see details below.  

New Transfer Progress Amounts from engagement to engagement 

 Transfer Progress Amounts provides the ability to transfer a designated progress amount from one engagement to another 
engagement for the same client. 

• There is a new option from the Correct WIP button on the WIP Selection screen in billing named Transfer-Progress Amount 
for users when making billing selections.   

• There is an additional option on the main menu in Administration which provides the ability to transfer progress amounts.  
These transfers can be made ahead of the actual billing to accommodate upcoming client billing decisions which may be 
useful for firms that print Billing Worksheets and submit them to an administrative staff. 

• New security option ‘Transfer-Progress Amounts from one engagement to another’ exists under both Administration-
Activities and under Billing and defaults to “No”.  

• The Transfer Progress register that can be printed prior to making the transfer.   
• There is a new client standard report, Progress Transfers.  This report can be run for any period of time and the columns 

include: 

 date/time of the transfer 
  employee who made the transfer 
  client engagements 
  amount transferred 
  memo that is entered during the transfer  

• Standard AR Reports.  No changes have been made that impact standard A/R reports. 
• Standard WIP/AR Reconciliation.  Progress transfers will be reflected in the ‘Invoice Amount’ column on this report for the 

engagements that have moved progress amounts.  The total for the client will be the same as before the transfer.  
Individual engagement invoice amounts will increase and decrease because of the transfer. 

• WIP/AR Summary.  Progress transfers will be reflected in both ‘Progress’ and ‘Net WIP’ on the WIP/AR Summary Report 
where transfers of progress amounts will  increase or decrease individual engagements. 
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New Apply Progress Amounts in Billing for Multi Engagement Invoices 

 Outstanding progress amounts can now be applied for multi engagement invoices.  You are limited per engagement to the billed 
amount of the engagement. 

• In Practice Management billing you may apply outstanding progress amounts after selecting the amount to bill.  A new grid 
will display below the billed amount entry with a link to distribute any outstanding progress amounts.  The grid only 
displays when: 

 There is an outstanding amount of progress on one or more engagements  
 You are billing more than one engagement for an invoice 

• The new distribution screen provides progress amounts for each engagement to be applied. 
• When this process is completed the total progress applied is defaulted. 

Enhanced Client Billing Notes 

 New option to include all engagements when looking at client notes.  Client notes will continue to default to a specific client 
engagement, but does have a checkbox to view all engagement notes.   In addition the Client Notes button will now be italicized 
red when a billing note has been added for any engagement within the last 12 months.  

Enhanced Invoice Statuses 

 Additional custom invoice statuses available.   In the past, there were five custom statuses available for tracking the editing 
invoice process for your firm.  Now there are statuses 1-15 that you can customize the label for your firm process. 

Additional Columns added to the Billing Client List 

 Additional columns have been added to the client list in billing.    Four additional columns have been added to the client list in 
billing including:  Primary Partner, Billing Manager, Secondary Partner and Engagement Fee.  The labels for the client 
management will display the custom title if your firm has made a change in the firm setup. 

Enhanced Navigation 

 Billing Recap.   In the past, the button label “Continue” took the user a different location depending on where the user was when 
selecting the billing recap.  Now the button label “Continue” is replaced with the next specific window that will be displayed. 

 

Practice Management Integration with CCH Axcess™  Common Data 

Enhanced Daily Update to CCH Axcess™  .  Client contact notes are now available for the daily process. Additionally you will select a 
default employee to be associated with the client contact note if there is no employee on the note. 

 

Release 2015.15.02 / July 

We have devoted this release to making technology enhancements to Practice Management. Please see details below.  

Technology Upgrades 

Speed up the Accounts Receivable Post 

 The Accounts Receivable Post improvements.  Accounts Receivable has been re-factored to enhance performance.   
  Patch in August:  There was a patch necessary to correct the Accounts Receivable Post List of Payments Entered.  If you are a 

multi office firm and the employee lookup security for the employee posting payments is greater than one office but does not 
include all offices, the list of payments to post now displays. 

 

New Practice Management Printer Port  

 The Practice Management install now creates a printer port for use specifically with Practice Management.  In the past the 
Practice Management program used the first printer port available which turned out to be LPT1 resulting in conflicts with other 
programs such as versions of QuickBooks® and Quicken®.  Now the new port and enhanced coding will resolve conflicts with 
other programs. 

 

Additional Printing Enhancement  
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 The Practice Management now correctly honors the printer’s setting for color, gray scale or black & white output. 
 

Emailing Documents having installed using Click to Run 

 Using Click to Run for MS® Office 2013 32 bit with Windows® 8.1 email now is not a problem. 
 

 
Desktop shortcut for custom reports 
SQL Server® 
 
 Using a desktop shortcut to launch custom reports is now not a problem. 
 

Practice Management is now compatible with: 
 
 Windows® 10 (except for Home and Mobile editions). 
 SQL Server® 2014 
 

 

Release 2015.15.01 / May 

We have devoted this release to making enhancements and corrections to various Practice Management modules. Please see details 
below.  

New Enhancements 

Practice Management Integration with CCH Axcess™  Common Data 

 New Option to Update CCH Axcess™  common data from Practice Management.   This new integration provides the ability to 
keep using Practice Management as your book of business while silently updating common data for use with your CCH Axcess™  
products such as Document, Tax and Portal on a daily basis. 

 
 Common data entered in Practice Management and updated in the CCH Axcess™  database: 

Client Profile including client contacts and client notes 
Employee Profile  
Regions 
Offices 
Departments 
Contact Categories 
Skill Level as Area of Expertise 
Line of Business 
Note Topics 
Work Type as Primary Service Type 
Client Responsible Staff  
 

 Steps To Integrate Practice Management Data for use with CCH Axcess™  products 

1. Sign up with your sales representative for a license at no charge.  
2. A member of our Consulting Implementation Team will contact you. 
3. The consultant will walk you through the initial migration of common data from Practice Management to the CCH Axcess™ ™ 

common database and get you set for daily updates. 
4. The program will automatically send an update for new and edited common data to the CCH Axcess™ ™ common database. 

 
 
 
 
 
 
 

Client Info 
Employee Info 

Firm Info 

DAILY ENTRY  
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New Regional Setting Recognition 

 Practice Management Recognizes Regional Settings  
 
       

  Regional Setting 
  English (US)  French (Canada)  English (Canada) 

Grids       
Short Date  MM/dd/yy  yyyy-MM-dd  dd/MM/yyyy 
Dollar Signs $ X.XX  X,XX  $  $ X.XX 
Separator X.XX  X,XX  X.XX 

        
Short Date  08/21/15  2015-08-21  21/08/2015 
Dollar Signs $2.00   2,00 $  $2.00  
Separator 2.00  2,00  2.00 

        
        

 

 Recommendations:  We recommend 2 digit day and month formatting to enable dates in columns to be aligned consistently.  

 Invoices and Statements:  French formatting is predefined based on the client’s invoice language entered in Client Setup. 

 

 

Employee Profile - CPA exam component update 

 Updated CPA Exam Labels  The Labels are: 

   AUD (Auditing), REG (Regulation), BEC (Business Environment & Concepts), FAR (Financial Accounting & Reporting) 

Labels replaced are: 

Law, ARE, FARE 

Report Writer In the past there were 5 components to the CPA exam.  If you created reports using these labels the report will 
continue to work.  On any new reports, your label choices are the 4 new labels. 

New Branding 

 CCH ProSystem Product Name Changes.   Practice Management replaces the ProSystem fx Practice Management product name.  
All CCH ProSystem fx products now include CCH branding. 

  

Practice 
Management 

CCH Axcess ™ 
Common Data 
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Year 2014 

 

Release 2014.14.03 / December 

Reports 

 New Client Budget to Actual to Invoiced report. 
This new report includes the project budget, the project actual WIP and in addition the invoiced amount with the realization 

percent for the project. 
 Enhanced Client Budget to Actual report. 

This report includes new summary options to view employee budgets against actual WIP regardless of the employee position. 
Other summaries include the type of work budgeted against the actual WIP. 

 Additional employee security options for all standard reports. 

Dashboards 

 Firm Dashboard – “My Clients” tab 
New option for Primary Partners and Bill Managers to select a client and jump to the billing module with the client selected. 

  2 New columns for all managers to view the last payment date and the last billing date. 
  New option for all managers to view un-posted WIP for a selected client. 
 Client Dashboard 

New option to view AR Aging for the first client tab. 

Project Tracking 

 Project Status  
There is a new option on the project status dialogue folder to email the next person when a detail task has been completed. 

Other 

 Contact Management 
There is a New WIP preference to add project information to the WIP grid. 

 Year End 
There are new warnings and messages to help users be successful in processing the firm year end. 

 Canada 
There are new help options for contact information specific to Canada. 

 Firm Client Lists 
There are new security options to prevent unauthorized employees from exporting the firm client list. 

 

 

Release 2014.14.01 / May 

Report Writer Report Templates 

50 new report templates have been added to the Report Writer. There are templates for every report type and we hope you find it 
much easier to start with a report template instead of starting from scratch using a report type. Report type functionality is still 
available. 

To create a report using a report template: 

• Click on the report template and click Save As.   
• You will be prompted for your firm report name.  
• Save your report name. 
• The report is created as a firm report and is available immediately for any edits that you may want to make to customize 

the report for your firm. 

Report Writer Redesigned Navigation Bar 

The Report Writer Navigation Bar has been re-organized.  
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 My Reports List 

At the top of the navigation bar you will find your firm reports in folders listed in blue and organized by the report type. 

 Available Report Templates 

The new report template folders are listed under the folder “Available Report Templates” in black and organized by the report 
type. 

Report Writer:  Report Template Booklet 

To review the new report templates use the hot link available at the bottom of the Navigation Bar for the Report Template Booklet. The 
booklet contains a snapshot of each report template, a list of key report writer elements for each report, an appendix with instructions 
and tips for creating and customizing reports, and an appendix that compares report templates with the same report type, side by side. 

Report Writer New Fields 

106 additional fields have been added to the various report types to expand the Report Writer capabilities. 

Report Writer New Report Type 

A new report type, Employee Forecast, has been added with 39 available fields to increase the reporting capabilities of the Forecast 
Hours feature that was introduced in the Practice Management 2013.13.01 release. 

Other Report Writer Enhancements 

 Added a blank line between subtotaled rows when printing reports with the detail level at ‘Show Detail’ or at ‘No Detail’ 
 On MTD/YTD report types, the YTD date range now displays the From and To dates 
 New splash screen which gives a brief overview of “How To” use the report writer 
 In customizing a report, the tab for selecting and editing columns now has a white background color to help notice at a glance 

when your column selections have gone over the available width and forced an additional row.  The second row is highlighted in 
gray and stands out against the white background. 

 Ability to change the font (type and size)  
 Page break can now be selected without selecting to sub-total at all detail levels for fields selected to group 
 When customizing a report, the ‘Remaining space for next column’  displays to assist with report customization 

Other Enhancements 

 Added a new security option for the Employee Time Analysis Report. This gives you the option to view the cost section of the 
report. 

 

2013 Extension Forms / February 

Extension forms are now available for Tax Year 2013. This patch is only needed if you print extension forms from Practice Management. 
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Year 2013 

Release 2013.13.01 / May 

Forecast Employee Hours 

My Week Forecast is now available on the Employee Dashboard to provide employees the ability to enter anticipated work hours for a 
week in advance. 

On the My Week Forecast tab of the Dashboard, enter the hours that you plan to work on clients for the upcoming week. The forecast 
grid provides a summary of the assignable hours and the forecast hours to see employee available hours for firm load balancing of work. 

Select the client from the client lookup. The client is a required field. 
 
Select the client project from the lookup if appropriate. 
 
The selection of the project is optional. If you select a project, the header on the bottom pane will display the due date, status 
and most recent milestone date. If detail tasks have been set up for the project the information for those tasks displays in the 
grid. This may be helpful, for example, if you are working on a 1040 project and want to check the budgeted hours associated 
with the task or want to see everyone associated with the project. 
 
Schedule button to the right of the project field will be enabled and you can view your scheduled detail tasks including hours for 
the forecast week as well as total hours for the detail task. 
 
Enter hours. You have been provided research if you are working on a client project but you are not required to enter the number 
of hours that have been scheduled or budgeted. Enter the number of hours you anticipate working on the selected client. 
 
Enter a reference. You have the opportunity to include a reference about the type of work without being required to enter a 
service code. 
 
Set My Hours. In addition there is an option to set your assignable hours for the week with security privileges. This provides better 
efficiencies to follow the constant changes to employee schedules. Implementation will depend on the security privileges for this 
option granted by the firm.  

 

Week At A Glance 

The Week At A Glance tab on the Firm Dashboard provides the ability to view anticipated client work hours for a week in advance 
by client management staff position. 
 
Select the new Week At A Glance tab from the Firm Dashboard and the calendar will display a week highlighted by default. You 
may override the selected week by clicking on any day on the calendar. This will also select the work week that contains that day. 
 
Any clients that you manage in the selected position when accessing the Firm Dashboard display if hours have been forecasted 
for the week highlighted on the calendar. The client, the client project, due date (if a project is used), as well as the forecast hours, 
display.  

 

Resource Dashboard 

We have added a new Resource Dashboard. For firms that choose to assign client work to their employees, the Resource 
Dashboard provides a view of employee forecast hours for a week as well as an alternate entry to assign client work. 
 
The Week Forecast tab on the Resource Dashboard displays a grid containing all employees with corresponding office, 
department, skill level, and employee status columns. Employee managers can filter the grid for appropriate groups of employees. 
Summaries are displayed including employee assignable hours for the week, any forecast hours entered, and the resulting 
available hours for client work.  
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The Enter Forecast Hrs tab on the Resource Dashboard displays the same forecast entry as found on the Employee Dashboard. 
This form provides a manager-driven method of assigning client work to employees. It can be used to assign all client work or it 
can be used to assign additional work when the available hours have been entered by employees and reviewed by client 
managers. If hours are entered in the Resource Dashboard, the employees will see the work assigned in the Employee 
Dashboard/My Week Forecast, with a symbol (“M”) to designate that it was assigned by a manager. 

 

Employee Week At A Glance Report 

The Employee Week At A Glance report is now available. This report helps your firm handle load balancing of client work. Use it 
weekly to analyze the employee workload and to match client work to appropriate employees who have availability. Report 
output includes employee assignable hours, forecast hours, and available hours. The report can be generated in summary or with 
the client/project/reference detail. It can be printed for multiple weeks or one week at a time.  

 

Options for Calculating Finance Charges 

Two new columns have been added to the finance charge grid for sorting and filtering. You will now find Primary Partner and Bill 
Manager as the two right-hand columns.  
In addition there are new options for printing Edit Lists. These options include: 
Group and Sort by: Clients, Primary Partner, Bill Manager 
Filter Option: Print only Selected Clients or Print All Clients in the List. 
While the Clients option continues to print in portrait, the Primary Partner and Bill Manager options print in landscape. 

 

 

2012 Extension Forms Download / January 

Extension Forms are now available for Tax Year 2012. These are only needed of you print extension forms from Practice Management.  
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Year 2012 

Release 2012.12.03 / December 

Practice Management is now compatible with:  

Windows® 8, Pro and Enterprise 
Windows® Small Business Server 2011 
Windows® Server 2012 
SQL Server® 2012 
 

SQLServer® 2008 R2 Express is now available with any new installation of CCH® ProSystem fx Practice Management. 

Microsoft® Office 2010 OEM and Professional (64 bit) are now supported. Outlook® (64 bit) will need to be open for Practice 
Management generated emails to be sent. 

Project Notes is now available in the Client Project List type report in Report Writer. 

 

Release 2012.12.02 / November 

NEW Project Based Time Entry 

Project Based Time Entry is now available as an alternate time entry method if your firm is project centric. In Project Based Time 
Entry, you enter the project before entering the service code for the transaction. You have the opportunity to set up a link 
between project types and permissible service codes, ensuring that your firm employees are entering accurate service codes 
available only for the project type. 
 
Enabling Project Based Time Entry is a 3-step process.  
First, set up the links between project types and service codes.  
Then enable security for employees who will now use Project Based Time Entry. 
Finally, decide whether your firm will require the selection of projects. A new option is available to require projects for nonbillable 
clients. 
 
To start, select Project Types from the navigation bar in Administration (or select Project Management > Create Lists > Setup 
Project Types). Select the project type for the linking and select the Link Service Codes tab. All service codes are linked by default. 
A quick way to create your link is to right-click, exclude all service codes, and then include only the service codes for this project 
type by clicking the Included check box. Quickly select to include multiple services by right-clicking a category or subcategory to 
filter down to a specific subgroup of services and then right-click again to include all. Linking service codes provides more 
accurate reporting by filtering the available service codes in Project Based Time Entry to just those defined for each project type. 
Once you have your service codes linked, enable security for employees who will use Project Based Time Entry. Select Security 
Setup from Administration > Firm. Look for Time Entry – Project Based Entry. Two options are available in this group.  
Click Yes for Time Entry – Project Based Entry to turn on Project Based Time Entry. In this entry method, the project is entered 
before the service code. The available service codes will be filtered if you have linked service codes to the project type.  
If you want to make available the option to override the linked service codes for any project, click Yes for Allow override of service 
codes. 
 
When entering time in Project Based Time Entry, you will see that the project is the second entry item after the client name. 
Enter the project before entering the service code. Once you enter the project, the linked service codes for the project type are 
available in the service code lookup. If you have security to override the filtered list, click the Trim/Un-trim button [<] [>] to 
display/trim the full list in service code lookup. This may be helpful, for example, if you are working on a 1040 project and need to 
enter an expense service code (such as postage) which could be used for any project type. 
 
Note also that if employees use Timers, the Timer window will also display in Project Based Time Entry order if this alternate time 
entry method is selected for the employee. 
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Time Entry Project settings for nonbillable clients are now available in Firm Setup > Time Entry.  

If you select to require selection of a project in Time Entry on this tab, you can also now require the entry of a project for 
nonbillable clients as well. If you select both check boxes, “No Selection” is not an option for project selection in Time Entry. 

 

NEW Timesheet Column Preferences 

Preferences for Timesheet Columns are now available. All staff members now have the ability to set up their preferences for the 
columns to view in their timesheet. 
 
Select My Time Entry Column Order from the Preferences menu to customize the columns in your timesheet in Time Entry. The 
Selected Column list shows the current columns. By default, all columns display in the Selected Columns list the first time you 
open this preference. You can change the order of columns by moving them up or down in the list. Remove any unwanted 
columns from the list by highlighting them and clicking <- Remove to move them back to the Additional Columns Available list. 

 

NEW Employee Semi Monthly Timesheet Available in Time Entry 

The Employee Semi Monthly Timesheet report has been added to the Activities menu in Time Entry. It is also still available from 
the Reports module. This is helpful for firms who want employees to sign and submit a report for payroll purposes. 

 

NEW Client Notes Location in Client Dashboard 

Dashboard Notes now display on a separate tab in Client Dashboard giving you the opportunity to scan multiple notes at a 
glance. You can now add a note from the Client Notes tab in Dashboard. Marketing ticklers, follow-ups, and appointments can 
also be added by selecting the New button. You can also edit or delete any note, tickler, follow-up or appointment from this tab. 
Additionally, notes can now be printed from the Client Notes tab in a report format sorted by type, source, topic, contact, date, 
or employee. 
 
As a new tab, the security for the Client Notes tab is disabled for all users. To simply allow access to the tab for all users, select 
Default for All Employees in Security Setup (Administration > Firm > Security Setup), look for Client Notes under Client 
Dashboard and select Yes. To set the Client Notes tab as a default tab, select User Options > User Default View > Client 
Dashboard and select Client Notes. 
 
From the Client Dashboard, select the Client Notes tab. You may add, edit, or delete client notes as well as marketing ticklers, 
follow-ups, and appointments from the Dashboard. By default, the Summary check box is selected, displaying only the first 
portion of each note. To view the entire text of a single note, select the note and the content will display in full at the bottom of 
the tab. To view the complete text of all notes for the selected client, clear the Summary check box. 
 
You can also select which columns of information to view. Select My Notes Column Setup from Notes Column Preferences to 
select from Type, Source, Topic, Contact, Date, Employee, and Note. By default, all columns display in the Selected Columns list. 
You can change the order of columns by moving them up or down in the list. Remove any unwanted columns from the list by 
highlighting them and clicking <- Remove to move them back to the Additional Columns Available list. 

 

NEW Clearing Project Notes 

Clearing Project Notes when Rolling Projects into the new year is now available. This may be useful if your firm migrated data and 
uses project notes tied to a specific year (for example, for the 2011 Tax season). If your firm uses the Auto Roll feature, the option 
to clear the notes from a project can be configured for each project type within the Project Type setup (select Project Types from 
the navigation bar in Administration or select Project Management > Create Lists > Setup Project Types). A new check box, Clear 
the project note in the new year, displays on the Auto Roll Forward tab. Select this box to clear the note when the project is 
automatically rolled forward. 
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If your firm does not use the Auto Roll feature, a new check box, Clear the project note in the new year, displays on the Project 
Options tab of the Roll Multiple Projects to New Year window. Enable this check box to clear notes for the selected projects when 
rolling projects to the new year. 

 

NEW Client Billing Realization Report 

The Client Billing Realization report is now available. This report helps you determine the profitability of clients, employees, 
partners, managers, billers, offices, work codes, etc. Use it whenever you need to analyze the historical activity in your firm. The 
report generates a billing realization showing total billed hours, standard production amounts, invoiced amounts, write-
ups/write-downs, cost, profit, gross progress, and gross payments based on the selected invoice post date range. Detail options 
include category, subcategory, service code, and project. 

 

NEW Employee Time Analysis Report 

The Employee Time Analysis report prints a summary of employee current period and year-to-date posted hours and amounts. 
This report helps you monitor how effective your staff has been by analyzing how much time every employee spends on each 
client, project, and work type. Production and cost summaries can be included for additional analysis. Detail options include 
category, subcategory, service code, client engagement, and project type. 

 

NEW WIP AR Summary Report – Un-posted WIP 

The WIP AR Summary now includes an additional column for Un-posted WIP. 

 

NEW Updated Look 

Practice Management now has an updated look and feel for navigation bars and buttons. Navigation bars have a light blue 
background with blue text while buttons have blue borders. All navigation bars and buttons function the same as in previous 
versions of the software. 

 

Release 2012.12.01 / May 

We have devoted this release to making enhancements and corrections to the following areas of Practice Management: After installing 
this release, we recommend staff security for the new Project Dashboard, the new Self Assign feature for Project Tracking, and the new 
Firm Dashboard tab for My Project Overruns be set up to take advantage of the new features in this release. 

 

Practice Management Report Writer has a new look and feel. The Report Writer now opens fully maximized for ease of use requiring 
new minimum screen resolution of 1024 x 768. 

New Main Window: Upon opening, a right-hand window displays. This window contains a quick overview of available options 
when creating or editing reports. Navigate easily and quickly from the Report List to the Customize mode or to the Run mode.  
 
Select a Report Type, and the Customize mode options display. Once the report is saved, the Run mode can quickly be launched 
from within the current window. Select an existing saved report and the Run mode options display to configure the printing 
parameters and print. You can also easily return to the Customize mode. 
 
Navigation bar: Customize the Custom Report has been added to the right-click options for existing saved reports. Navigate from 
report to report and stay in the navigation bar once in Customize or Run mode. 
 
Use splitter bars to size both the navigation bar as well as the right-hand window. Report Writer now saves and loads changes to 
your custom window sizes. 
 
Grouping and Sorting: A Grouping and Sorting tab has been added to the Customize options. Set the sorts and grouping options 
during the report’s creation. These selected sorts and groups default at print time. 
Custom Names: Client management positions and milestone dates now use custom firm names for selection on reports. 
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New Field Display Names:  
 
Standard prefixes have been added to column fields for ease of use in selection when creating new reports or adding or removing 
fields on existing reports. The new field display names will not affect existing reports unless a field is added. 

Type of Field New Prefix 

Accounts Receivable AR 

Banked Hours Bank-Use 

Billed WIP Billed 

Client Clt 

Client Management Clt Mgmt 

Due Date Milestone 

Employee Employee 

Project Project 

Project Detail Project Detail 

Service Service 

WIP WIP 

 

New Report Fields:  
Report fields have been added to several Report Types. 

New Field Name 

Client Profile Information 

Report Type 

Project Detail List 

 

New Field Name 

Client Active Date 

Report Types 

Accounts Receivable 

Billable Work in Progress 

Billed Detail 

Employee NonBillable Detail 

Employee Timesheet Detail 

MTD/YTD Client Production 

MTD/YTD Employee Production 

MTD/YTD Client Billing 
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MTD/YTD Employee Billing 

Project Detail List 

 

New Field Names 

Project Type 

Project Description 

Project InCharge 

Project Current Due Date 

Report Types 

Billable Work in Progress 

Billed Detail 

Employee NonBillable Detail 

Employee Scheduling 

Employee Timesheet Detail 

MTD/YTD Client Production 

MTD/YTD Employee Production 

MTD/YTD Client Billing 

MTD/YTD Employee Billing 

 

 

New Field Name 

Billable/Nonbillable 

Report Types 

Employee Timesheet Detail 

MTD/YTD Client Production 

MTD/YTD Employee Production 

 

New Field Name 

Clt Engagement Num (Engagement Code) 

Report Type 
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Accounts Receivable 

Billable Work in Progress 

Billed Detail 

MTD/YTD Client Billing 

MTD/YTD Employee Billing 

Project Detail List 

 

New Field Name 

Clt Name - Sort 

Report Type 

Accounts Receivable 

Employee NonBillable Detail 

Employee Timesheet Detail 

MTD/YTD Employee Production 

MTD/YTD Employee Billing 

 

New Field Name 

Clt Name - Full 

Report Type 

Employee Scheduling 

Project Detail List 

 

NEW Custom invoicing options have been added with this release. 

Custom Invoice Headers-Footers: Custom headers and footers can be added in Invoice Format Setup (Administration > Firm). To 
set up a custom header-footer set, enter the description and specify the language (English or French). You can associate a custom 
header-footer set with an office (or group of offices) selecting the check box(s) to the left of the desired office(s). Once the 
selections have been made, click Save Settings. Options are also available to select the font and size you want to use for your 
custom headers and footers. Review the existing selection on the Office Options tab in Firm Setup to determine if the current 
selection will continue to be the best option for the firm if assigning a custom header-footer as a default for an office. 
Override Header-Footer: Select to override the default Firm or the default Office header-footer with a custom header-footer in 
Client Setup (Billing tab). By default, no value will be selected. If a custom header-footer has not been selected and a default 
exists for the Office (as determined by the Office Options tab in Firm Setup), then the Office default will be used. If a custom 
header-footer has not been selected and an Office default does not exist (as determined by the Office Options tab in Firm Setup), 
then the Firm Default will be used. The Firm Default can be selected to override the Office default. 
Client Find and Change: Client Find and Change has been enhanced to include Override Default Invoice Header-Footer. Use this 
to quickly override default header-footer settings for multiple clients one at a time or all in one batch. 
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The Budget to Actual report has been enhanced.  

This Project report now can be printed with both hours and amounts for a total of 6 columns (7 columns if actual fees are also 
included). While the default remains to include just budget hours, both fees and surcharges may be selected if the report criteria 
includes both hours and amounts. 

 

The Employee Semi Monthly Timesheet report has been added.  

This NEW employee report prints timesheet information in up to 16 columns depending on the date range selected. The default 
date span is 16 days and the To Date will default to 16 days after the Start Date entered. The report includes a column for each 
day with separate billable and nonbillable sections and total rows. Billable and/or Nonbillable detail can be summarized. Detail 
rows can be sorted by Category, Subcategory, Service Code, Client Engagement, or Project Type. The report can be filtered and 
grouped by standard employee fields including Office, Region, Department, and Skill Level. 

 

NEW Dashboard options are now available. Security for these options has also been added to Security Setup and default to No. 

To check Dashboard security, select Administration > Firm > Security Setup and search for the Firm Dashboard-Project Overruns 
and Project Dashboard security areas. In addition, there is a new security setting for employees to assign themselves to projects 
on the new Project Dashboard. You will find the Self Assign security in the Project Tracking (Dashboard) Privileges section of 
Security Setup. 

 

Project Dashboard 

A NEW Project Dashboard now displays Project Tracking views. You can also set project status from this dashboard. To access the 
Project Dashboard, set up security for employees in the Project Dashboard security area in Security Setup. By default, this option 
will be disabled for all users. Like all Dashboards, the Project Dashboard can be set as the default view upon launch of the 
Dashboard. 
 
The default Track Projects view shows project information based on the criteria selected from the navigation bar. Options include 
loading the project by Project Type, Client, Project Status, Primary Partner, Secondary Partner, Responsible Person, Manager, Bill 
Manager, Tax Reviewer, Tax Preparer, In Charge, Entity Type, Work Type, Line of Business, Assigned Position, Assigned Employee, 
Assigned Skill Level, and Assigned Team. Once the grid has been loaded, use the View Projects, Project File Locator and Set 
Project Status buttons to help track the projects. To adjust column preferences, see Project Tracking Column Preferences and 
select Project Tracking Column Setup. 
 
The NEW Track Milestones view provides a view of projects as they move through the firm, from waiting for information to the 
delivered project. Each milestone displays the most recent project milestone date that has been updated for the project. These 
dates include: Received, Prepared, Reviewed, Completed, and Delivered. Select Waiting for Information to build a list of projects 
which have yet to achieve a milestone. Once the grid has been loaded, use the View Projects, Project File Locator, and Set Project 
Status buttons to help track the projects. To adjust column preferences, see Project Tracking Column Preferences and select 
Project Tracking Column Setup. 
 
The NEW Track Detail Tasks view provides a view of the detail tasks that have been set up for a project. Load the grid with detail 
tasks by Client, Assigned Position (including All, No Selection, as well as each project position set up in Project Management), 
Assigned Employee, or Assigned Skill Level. Static columns include Sort Order Date, Client Sort Name, and Received. The default 
columns include Project Type, Project Position, Employee Last Name, Employee First Name, Client Number, Engagement 
Number, Detail Budget Hours, Budget Amount, Expense, SC Cat, SC Sub, SC Detail, Budget Item Completed, In Charge, and 
Client Name. Available columns include Project Description, Project Start and Target Date, Team, Detail Task Start and Target 
Date, Office, Skill Level, and Note. 
To change the column preferences, see Project Tracking Column Preferences and select Project Detail Tasks Column Setup. 
 
A NEW Self Assign option is available when displaying projects in Track Detail Tasks view By Assigned Position (with the 
exception of by ALL). This option enables employees to assign themselves to a chosen project task, if an employee has not been 
assigned. If another employee is already assigned, a message displays informing the employee that the change could not be 
made. This new option provides quick visibility for the firm. To enable self assign for employees, go to Security Setup and the 
Project Tracking (Dashboard) Privileges section. 
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Firm Dashboard Enhancement 

A new tab, My Project Overruns has been added to the Firm Dashboard. Select the tab to list projects along with columns for the 
associated budgeted, actual and variance hours as well as amounts. By default, the Show Overruns ONLY checkbox is enabled. 
Overruns can be displayed by Hours or Amounts. 
Security for this new tab is available in the Firm Dashboard section of Security Setup.  By default, this option will be disabled for 
all users. 
 
Project Tracking has been enhanced. Two new views (Track Milestones and Track Detail Tasks) have been added. These views have 
the same functionality as their Project Dashboard counterparts. A column preference has been added for the Track Detail Tasks 
view (My Project Detail Tasks Column Setup). The Self Assign option is also available in Track Detail Tasks on the Assigned 
Position view. 

 

2011 Extension Forms Download / January 

Extension Forms are now available for Tax Year 2011. These are only needed of you print extension forms from Practice Management.  
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Year 2011 

Release 2011.11.03 / November 

On the Practice Management 2011.11.02 October release, the Roll Projects to New Year feature was enhanced with a new view for 
projects already rolled to the new year. However, the view of unrolled projects still showed rolled projects if the project description was 
cleared or changed during the roll. The view of unrolled projects has been corrected to no longer include projects with changed 
descriptions following a roll of one or more projects. 

 

Release 2011.11.0 / October 

NEW Dashboard Enhancements 

Practice Management has a NEW Client Dashboard designed to combine client data from multiple areas into a single easy to use tool. 
Many additional enhancements have also been implemented for existing Dashboards. Standard Practice Management grid controls can 
be applied to further filter, print, or export the displayed data. 

Please review security for the entire Dashboard module after updating to 2011.11.02 to validate that each staff member has the 
appropriate access for their position within the firm. 

 

NEW Client Dashboard 

This dashboard is designed for firm management and includes four tabs: 
 
Contact Information:  

This tab consists of five panes divided into two main sections. The General Information, Notes, and Contacts panes 
display in the upper section while the Balances and Invoices panes display below. 
The General Information pane provides basic information including physical and mailing addresses, assigned staff, 
and other profile information such as fiscal year end and taxpayer ID. The client’s physical and mailing address can be 
edited from this pane. 
The Notes pane displays all notes, appointments, follow-ups or tasks associated with the selected client in grid 
format. Select an item from the grid to display the detail. To edit a note, simply double-click the desired note. 
The Contacts pane shows each of the contacts for the selected client. To edit a contact, select the contact and click 
Edit Contact. New contacts can be created as well as existing contacts deleted. Notes for contacts can also be 
viewed.  
The Balances pane allows for quick review of the client’s Billable WIP, Progress, Net WIP, AR Balance as of the 
current system date/time as well as Last Invoice Date. 
The Invoices pane lists each of the client’s current outstanding invoices including the original amount and any 
outstanding amount per engagement. To view an invoice, simply double-click anywhere on the row for the desired 
invoice. 

 
PTD/YTD Activity: This tab consists of two panes.  
 

The PTD/YTD Activity pane reconciles the WIP and AR activity for the selected client based on the chosen date 
range. 
The Activity Detail pane is further divided into PTD and YTD tabs listing the posted WIP and AR detail for the chosen 
date range. Each column is totaled at the bottom of the grid. 

 
Current / Prior Year: This tab consists of two panes. 

The Monthly Comparison pane shows current and prior period Production, Billed Hours, Billed Amount, Billed 
Adjustments and Payments broken down by month for up to 12 months for the selected client based on the chosen 
date range.  
Optionally you can choose to view the data in the Monthly Comparison pane for only billable WIP.  
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The Production pane is further divided into two tabs: Employee and Service Code. The Employee tab shows the 
difference between production and billing totals for the selected client within the chosen current and prior periods 
by employee. The Service Code tab shows the difference between production and billing totals for the selected client 
within the chosen current and prior periods by service.  

 

All Engagements:  

This tab shows engagement specific information such as the engagement’s description, fee and date of the last 
invoice. In addition, current and prior Production, Billing, and AR display for comparison broken down by months 
within the firm’s fiscal year. You can choose to see just one type of information, for example Billing, or select Show 
All 3 to see all three types of information. Information can be summarized for multi-engagement clients. 

 

Dashboard Security 

Dashboard security has been enhanced to provide more security flexibility and control access to each dashboard as 
well as to individual tabs. The Firm and Client Dashboards default to disabled for all users. Previously, security for the 
Firm Summary tab of the Firm Dashboard was linked to rights to the Firm Management Key Indicator report under 
Time Entry. The Employee Dashboard defaults to enabled for all users.  

 

Please review Dashboard security to verify that access is appropriate for each of your firm’s staff members, based on 
their firm position.  
 
To check Dashboard security, select Administration > File > Security Setup and search for the Firm Dashboard, 
Employee Dashboard, and Client Dashboard security areas. 

 

Dashboard Accessibility 

Access Dashboard like any Practice Management module using the Features menu or Tray. To open Dashboard from 
another module, select the Features menu and choose Dashboard. From the Tray, right-click the Tray icon, navigate 
to Practice Features Launcher, and choose Dashboard.  
 
Dashboard can also be set as the default module by double-clicking the Tray icon. To set Dashboard as the default 
module, right-click the Tray icon and select Preferences. On the General tab, verify Practice Features Launcher is 
selected. Select Practice Features Launcher from the navigation bar. Click the drop-down for Default Feature, choose 
Dashboard, and click Save. Double-click the Tray icon and the Dashboard module launches. 

 

Firm Dashboard Enhancements 

Firm Dashboard by Client Mgmt Position: Separate firm level dashboards for each client management position are replacing the 
single firm level dashboard. Each client management firm level dashboard has the same tabs: Firm Summary, My Summary, My 
Projects, and My Clients. The data loads differently for the Firm Summary tab than for the other tabs. For example, selecting Firm 
Dashboard by Bill Manager loads and presents data for the Firm Summary tab by Bill Manager for all clients regardless of staff 
assigned as Bill Manager. The data for the My Summary, My Projects, and My Clients tabs loads based on client staff assignment 
loading only those clients to whom the logged on employee is assigned as Bill Manager. To set a particular client management 
node of the Firm Dashboard as a default, select User Options > User Default view. 
Firm Dashboard – My Projects (Notes): A Note pane has been added at the bottom of the grid on the My Projects tab to broaden 
the accessibility of this feature. The Note pane at the bottom of the grid is the same as the Note pane within a project’s folder 
and functions in a similar manner.  
To view a project’s notes without opening the project, simply select the project and the associated note displays in the Note pane 
at the bottom of the grid. To add or edit a note, select the project and click into the Note pane.  
Firm Dashboard – My Clients: A new tab, My Clients, has been added to the Firm Dashboard. Select the tab to load a list of clients 
based on the selected client management position. Client order defaults to client code displaying totals for Un-posted WIP, 
Billable WIP, Progress, Net WIP, and AR Balance. Un-posted time is NEW. All displayed totals are current as of the system 
date/time.  
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Employee Dashboard Enhancements 

Employee Dashboard – My Time: Banked and Used hours have been added as distinct views to Timesheet Lookup pane of the My 
Time tab of the Employee Dashboard.  
The Banked view displays transactions where time was banked for future use as well as the timekeeper’s Yearly Allowance, Hours 
for Date Range, and Remaining Hours. 
The Used view displays transactions where time was banked for future use as well as transactions where banked time was used. In 
addition to the detail, the Used view shows Total Banked, Total Used, and Net Hours. 
To select either the Banked or Used views, select My Time within the Employee Dashboard. Select either the Banked or the Used 
view from the View drop-down for the Time Entry Lookup pane. 

 

Additional Practice Management Enhancements 

Firm 

Preventing entry of non-billable time to billable clients is a new Firm level option. When enabled, this new option prevents 
timekeepers from charging a non-billable service to a billable client. Firm Administrators can still use Correct WIP to correct a 
billable service to a non-billable service if desired. 
To enable the option, open Firm Setup selecting the General Information tab and deselect the check box for Allow Non-billable 
Time to Billable Clients in Time Entry. This option applies to all timekeepers. 

 

Contact Management 

Invoiced WIP can now be viewed along with unbilled WIP on the WIP tab within the Individual Clients lookup in Contact 
Management. 
To view the historical WIP, select the WIP tab within the Individual Clients lookup and check the box for Include History. Once 
selected the option remains enabled. 
An additional column for Invoice No is now available for selection to help distinguish billed WIP from Unbilled WIP. If a value in 
this column is zero, it represents unbilled WIP. This additional column can be added and positioned from the Preferences menu 
option My Contact Management Info/WIP. Once added, the Invoice No column may be used to sort and filter WIP details. 

 

Project Management and Project Tracking 

A Project Note pane has been added at the bottom of the grids in Project Management and Project Tracking to broaden the 
accessibility of this feature. The Note pane at the bottom of a grid is the same as the Note pane within a project’s folder and 
functions the same.  
To view a project’s notes without opening the project, simply select the project and the associated note displays in the Note pane 
at the bottom of the grid.  
To add or edit a note, select the project and click into the Note pane. 
 
When rolling projects options for building the list of clients to determine whose projects should be rolled have been enhanced. 
The list can now be built to show only projects not already rolled, only projects that have been rolled, or all projects. 

 

Time Entry 

Banked and Used hours have been added as distinct views to Timesheet Lookup for online timekeepers.  
The Banked view displays transactions where time was banked for future use as well as the timekeeper’s Yearly Allowance, Hours 
for Date Range, and Remaining Hours. 
The Used view displays transactions where time was banked for future use as well as transactions where banked time was used. In 
addition to the detail, the Used view shows Total Banked, Total Used, and Net Hours.  
To select either the Banked or Used views, select the Timesheet Lookup tab in Time Entry. Select either the Banked or the Used 
view from the View drop-down. 
Note that this feature is designed for online timekeepers. 
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Release 2011.11.01 / May 

NEW Dashboard 

Practice Management has new dashboards designed for firm partners as well as firm employees.  These dashboards can be set up to 
display first when logging into the Practice Management application.  You can specify which tab of the dashboard to display on entry.  If 
you have shortcuts to Practice Management modules on your desktop, you should consider adding a shortcut to the new Dashboard 
option so you can quickly access your personal data snapshot before entering further into the application.  

 

Firm Dashboard 

This dashboard is designed for firm management and includes 3 tabs: 
Firm Summary: This tab includes all of the firm partners and displays the Work In Process, Billing, and Accounts Receivable panes 
for Period-To-Date as well as Year-To-Date totals.  Click on any partner on the Firm Summary panel to reflect information for 
only that partner. A variety of graphs is also available on these tabs to assist with interpreting firm information. From the graphs 
you can print, save as an image, or export to Excel®. 
My Partner Summary: This tab is designed to reflect your partner statistics only without the entire partner list. 
My Partner Projects:  This is a list of projects for clients where you are the partner and the projects have not been delivered. 

 

Employee Dashboard 

This dashboard is designed for firm employees and includes 3 tabs: 
My Calendar View: This is a month view of your time, budgets and availability. 
My Time:  This is a two-week glance at your time. 
My Assignments:  This is a list of projects where you have been assigned to a task. 

 

Default View 

You may choose the tab on the Dashboard that will be your default view as you enter Practice Management.  To do so, select 
User Options > User Default View. 

 

Requirements 

1024 x 768 or higher resolution is required for Dashboard. 

 

Security 

Dashboards and the features on the Dashboards are controlled by your existing security setup. The Firm Summary tab of Firm 
Dashboard is available to those with security for Firm Management Key Indicators - Firm Management Report in Security Setup. 
The My Partner Summary and My Partner Projects tabs are available to employees assigned to one or more clients as a partner. 

 

Administration 

Billing has been added as a new note type in Client/Prospect Note Setup. When printing Billing Worksheets, a new option to 
include Billing Notes enables you to print them on the worksheets. 
Credit Card now defaults as an entry in the Bank Account list for new installations/databases of Practice Management. 
 

Accounts Receivable 

The option to summarize finance charges has been added to the new Format tab in Print Accounts Receivable Statements. This 
new tab also includes Format Type (Balance Forward or Open Item), formerly on the Page Setup tab, as well as the option to 
suppress printing of voided entries formerly on the Print Criteria tab. If you select to summarize finance charges, the description 
of Finance Charge prints as the last row in the current activity section of the statement without a date. The amount is the sum of 
outstanding finance charges and any applied debits and credits through the user-defined cutoff date.  
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Billing 

Change Bill Thru Date button has been added to the main billing form. This functionality has also been retained as a button 
within the Client Detail Billing. When the Bill Thru Date is changed, a new column displays on the main billing window to assist 
with your billing decisions. This column contains all posted billable WIP entered on or before this date, netted with any unapplied 
progress, for each client in the list. 
 

Project Management  

Automatic Roll Forward can now be set up for any project type. A new Auto Roll Forward tab in Project Type allows you to set 
this option. Three options are available to keep the existing description, clear existing description, or use a new description. This 
automated roll forward will function only for projects without budget detail. 
To initiate the roll forward for a project with an auto roll enabled project type, enter the Delivered Date for the project by 
updating Tracking Status from any online module in Practice Management. When you click OK, the project will roll forward to the 
new year. 
Note that for existing projects, enabling of auto roll for a project type may affect existing delivered projects that have not yet 
been rolled to the new year if these projects’ tracking dates are reviewed. 

Reports 

New Secondary Sorts are now available on the following reports: AR Cash Receipts, AR Balance Listing, AR Collections, and Billing 
Report. Each primary staff position sort (for example, Primary Partner) can be further sorted by either a secondary staff position 
sort (for example, Primary Partner by Bill Manager) or a secondary staff position sort and a sort by group (for example, Primary 
Partner by Bill Manager by Group). Each secondary sort method continues to allow the ordering of the report output by Client 
Code, Client Sort Name, Client Master – Code, or Client Master – Sort Name. 
 
The Billing Worksheet now includes the option to include new Billing Notes. It also prints WIP Thru MM/DD/YYYY based on the 
detail criteria date to assist when identifying the make-up of WIP on the worksheet during the billing process. 

 

2010 Extension Forms Download / January 

Extension Forms are now available for Tax Year 2010.  
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Year 2010 

Release 2010.10.03 / October 

Reports 

WIP/AR Reconciliation now accurately reports WIP Prior and Current balances when using date range criteria equal to either 
Current Year or Prior Year in conjunction with a start date not equal to the first day of the firm’s fiscal year. 
 
Client Ledger now accurately reports WIP Prior and Current balances when using date range criteria equal to either Current Year 
or Prior Year in conjunction with a start date not equal to the first day of the firm’s fiscal year. 

 

Release 2010.10.02 / September 

GL Interface 

General Ledger Interface is now available for Client Accounting Suite. To set up the interface, select General Ledger Interface 
from the File menu in Administration. Use this interface to create journal entries from Practice Management. Transactions will be 
written to a table which can be imported into Client Accounting Suite for General Ledger reporting. 

Payroll Interface 

Payroll Interface is now available for Client Accounting Suite Payroll. To set up the interface, select Payroll Interface from the File 
menu in Administration. Use this interface to transfer payroll timesheet information from Practice Management to Client 
Accounting Suite Payroll. Paychecks can then be printed in Client Accounting Suite Payroll. 

 

Release 2010.10.01 / September 

Firm 

Three new default invoice formats are now available: Project WIP Detail – By Category, Project WIP Detail – By SubCategory, and 
Project WIP Detail – By Service Code. 
 
These invoice formats group WIP transactions by category, subcategory, or service code ordered by date and subtotaled by 
project. 

 

Contact Management 

Open AR Balance Only is a new checkbox on the AR tab of Contact Management. Selecting this new checkbox removes items 
paid in full, showing only those items on which an outstanding balance is owed. This checkbox is a per user option and remains 
selected regardless of client until it is deselected. 
AR Net is a new column you can add to the AR tab of Contact Management to show the net amount remaining for those items 
with an outstanding balance. To add this column, go to Preferences/My Contact Management Info/AR. 

 

Reports 

New Secondary Sorts are available on the following reports: AR Aging, AR Reconciliation, Billing Worksheet, WIP/AR Aging, 
WIP/AR Reconciliation, and WIP/AR Summary. 
 
Each primary staff position sort (for example, Primary Partner) can now be further sorted by either a secondary staff position sort 
(for example, Primary Partner by Bill Manager) or a secondary staff position sort and a sort by group (for example, Primary 
Partner by Bill Manager by Group). 
 
Each secondary sort method continues to allow the ordering of the report output by Client Code, Client Sort Name, Client Master 
- Code, or Client Master - Sort Name. 
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Features Menu 

CPE Assistant is a new link on the Features menu to the website http://cpeassistant.com. This tracker helps CPAs monitor and 
maintain their CPE certification. 

 

Help Menu 

Technical Support selection on the Help menu is now called “Practice Management support on the web.” Six additional selections 
have been added under the updated Help menu option: 
   Product Home Page 
   Product Updates 
   efx-News 
   Browse our Knowledge Base 
   Contact Support 
   My Account 

 

2009 Extension Form Download / January 

Extension Forms are now available for Tax Year 2009.  

 

http://cpeassistant.com/
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